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SUMMARY

The innate immune response is critical for animal ho-
meostasis and is conserved from invertebrates to
vertebrates. This response depends on specialized
cells that recognize, internalize, and destroymicrobi-
al invaders through phagocytosis. This is coupled to
autonomous or non-autonomous cellular signaling
via reactive oxygen species (ROS) and cytokine pro-
duction. Lipids are known signaling factors in this
process, as the acute phase response of macro-
phages is accompanied by systemic lipid changes
that help resolve inflammation. We found that perox-
isomes, membrane-enclosed organelles central to
lipid metabolism and ROS turnover, were neces-
sary for the engulfment of bacteria by Drosophila
and mouse macrophages. Peroxisomes were also
required for resolution of bacterial infection through
canonical innate immune signaling. Reduced perox-
isome function impaired the turnover of the oxidative
burst necessary to fight infection. This impaired
response to bacterial challenge affected cell and or-
ganism survival and revealed a previously unknown
requirement for peroxisomes in phagocytosis and
innate immunity.

INTRODUCTION

An organism relies on innate immunity for survival early after
exposure to a microbial pathogen. Innate immunity depends
upon specialized cells that recognize conserved features of mi-
croorganisms to elicit an appropriate antimicrobial response
(Blander and Sander, 2012). Removal of microbial pathogens
by these cells requires phagocytosis (Aderem and Underhill,
1999; Gordon, 2016; Stuart and Ezekowitz, 2008), an event
that includes recognition, engulfment, and clearance of the path-
ogen. Formation of a phagosome starts with microbes binding to
phagocytic receptors, triggering reorganization of the plasma
membrane and underlying cytoskeleton to facilitate engulfment
(Aderem and Underhill, 1999). Recognition and internalization
of bacteria trigger activation of signaling pathways that induce
cell autonomous and non-autonomous immunological re-
sponses (Buchon et al., 2014; Gordon, 2016).

Phagosome formation is well characterized, and the key pro-
teins involved have been largely identified (Garin et al., 2001).
Much of what is known about phagocytosis has come from
studying macrophages, the most actively phagocytic cells in
higher metazoans. The process of phagocytosis is conserved
in the fruit fly Drosophila. Flies have circulating macrophages
called hemocytes with properties similar to those of mammalian
macrophages (Rizki and Rizki, 1980). The Drosophila Schneider
2 (S2) cell line is functionally analogous toDrosophila hemocytes.
Peroxisomes are organelles found across the eukaryotes.

Conserved Peroxin (Pex) genes encode proteins that are
required for peroxisome formation and maintaining peroxisome
populations (Smith and Aitchison, 2013). Peroxisomes function
in lipid metabolism and the detoxification of reactive oxygen
species (ROS) (Nguyen et al., 2008; Wanders and Waterham,
2006). As lipids and ROS have recently emerged as important
signaling factors in cellular and systemic immune responses
(Nathan and Shiloh, 2000; Neyen and Gordon, 2014), we investi-
gated a role for peroxisomes in the innate immune response us-
ingDrosophila cells and animals in which two key peroxin genes,
Pex5 and Pex7, were impaired. We found a previously unknown
role for peroxisomes in microbe engulfment and host defense by
macrophages. Both cultured cells and adult flies with impaired
peroxisomes had a reduced capacity to respond to microbial
pathogens and exhibited defects in immune signaling and
reduced viability. We observed a similar requirement for peroxi-
somes in microbe engulfment in murine macrophages. Our find-
ings demonstrate that peroxisomes are essential for the activa-
tion of, and successful defense by, the innate immune system.

RESULTS

Pex5 and Pex7 Are Required for Phagocytosis by
Drosophila Cells
Pex5 and Pex7 are conserved receptors that recognize peroxi-
somal proteins made in the cytosol and target them to the
peroxisomal matrix. RNA interference (RNAi) of Pex5 or Pex7
compromises peroxisome function (Baron et al., 2016; Braver-
man et al., 1997; Mast et al., 2011). We analyzed the effect of
RNAi of Pex5 (Pex5-i) and Pex7 (Pex7-i) in Drosophila GFP-
SKL S2 cells (Figure S1A) infected with the Gram-negative bac-
terium, Escherichia coli. GFP fused to the peroxisomal targeting
signal type 1 (PTS1) Serine-Lysine-Leucine-CO2H (SKL) labels
peroxisomes. Control cells efficiently phagocytosed E. coli (Fig-
ures 1A, Control; and 1C) and latex beads (Figure 1B, Control).
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Figure 1. Pex5 and Pex7 Are Required for Phagocytosis
(A) Drosophila S2 cells (Control) have multiple peroxisomes (anti-SKL, green) and internalize E. coli (red, arrows). The actin cytoskeleton (blue) was stained with

phalloidin. Cells treated with dsRNAs targeting Pex5 (Pex5-i) or Pex7 (Pex7-i) bound, but did not internalize, E. coli. Scale bar represents 10 mm.

(B) Control cells bound and internalized latex beads (green). Pex5-i cells or Pex7-i cells were blocked in phagocytosis, as all beads were outside the cell.

(C) Percentage of E. coli cells or C. albicans cells attached to the plasma membrane (membrane-bound) or internalized by cells.

(D) Reduced phagocytosis is specific for depletion ofPex5 andPex7. Cells were incubatedwith equal numbers of E. coli cells for 2 hr or 16 hr. After incubation, the

E. coli cells remaining were counted (CFU). No significant difference from control was seen when Pex23 was depleted (Pex23-i). Values reported in (C) and (D)

represent the averages of 8 and 5 independent experiments ± SD. Statistical significance was determined using Student’s t test; ***p < 0.001; **p < 0.01; ns = not

significant. Please see also Figures S1 and S2 and Videos S1, S2, S3, S4, S5, S6, S7, S8, and S9.
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Pex5-i and Pex7-i cells exhibited reduced phagocytosis of E. coli
and latex beads (Figures 1A–1C). The roles of Pex5 and Pex7 in
whole animals in response to bacterial infection were examined
via targeted expression of transgenically encoded double-
stranded RNA in larval hemocytes. Hemocytes from control
larvae exhibited substantial internalization of heat-killed E. coli
zymosan particles, compared to the relatively limited internaliza-
tion observed in Pex5-i or Pex7-i cells (Figures S1B and S1C).
SCAR (suppressor of cAMP receptor) is a major regulator of

phagocytosis in Drosophila (Stroschein-Stevenson et al., 2006;
Zallen et al., 2002). Multi-spectral imaging flow cytometry (IFC)
showed that Pex5-i, Pex7-i, and SCAR-i cells exhibited reduced
uptake of E. coli compared to control cells (Figure 1C). This
reduction was not specific for E. coli, as Pex7-i cells exhibited
a similar reduction in uptake of the yeast Candida albicans (Fig-
ure 1C). The reduction in uptake was specific for Pex5-i and
Pex7-i cells, as cells with reduced amounts of Pex23 (Pex23-i),
which is not essential for peroxisome formation (Mast et al.,
2011), did not show impaired clearance of bacteria, even after
extended incubation (Figure 1D).

Pex5-i and Pex7-i Cells Show Defects in the
Cytoskeleton
Live-imaging of Pex5-i, Pex7-i, SCAR-i, and Pex13-i cells in-
fected with E. coli was done to examine the dynamics of the
cell-bacterium interaction. Pex13 encodes a peroxisomal mem-
brane protein required for protein import into peroxisomes
(Smith and Aitchison, 2013). After contact with bacteria, control
GFP-SKL cells formed many membrane protrusions, which was
followed by the formation of a phagosome cup and engulfment
of bacteria (Video S1). In contrast, cells depleted for Pex5,
Pex7, SCAR, or Pex13 bound bacteria at their surfaces, but no
phagosome cup was observed even after 14 hr (Videos S2–
S8). Membrane movement was impaired in these cells. The
compromised response to an external challenge of these
depleted cells was again not specific to E. coli as similar results
were obtained when Pex5-i cells were exposed to latex beads
(Video S9).
Defects in actin organization were seen in Pex5-i and Pex7-i

cells incubated with bacteria (Figure S2A). We assayed how
loss of peroxisomes affected cell motility by examining the ability
of cells to repopulate an area cleared of cells. Control cells
largely repopulated the area by 16 hr, while large areas without
cells were observed in Pex5-i cultures at 16 hr (Figure S2B).
Notably, the organized localization of SCAR seen in control cells
was disrupted in Pex5-i cells and in Pex7-i cells (Figure S2C),
consistent with the role of SCAR in actin polymerization and
the presence of an altered cytoskeleton in Pex5-i and Pex7-i
cells. IFC showed that SCAR-i cells also depleted for Pex5 or
Pex7 transcripts were unchanged in their uptake of E. coli rela-
tive to cells depleted for each gene individually (Figure S2D),
suggesting that Pex5, Pex7, and SCAR do not act in parallel
pathways.

Peroxisomes Localize to Sites of Phagosome Formation
The reduced uptake of E. coli by Pex5-i and Pex7-i cells was not
due to altered endosome formation, as the distribution of Rab5,
an early endosome marker, was similar in infected control,
Pex5-i, and Pex7-i cells (Figure 2A). However, the localization

of Lamp1, a late endosome and lysosome marker, was altered
in Pex5-i and Pex7-i cells incubated with bacteria compared to
control cells, showing that these depleted cells had fewer and
larger lysosomes compared to control cells and suggesting
thatPex5-i and Pex7-i cells that domanage to phagocytose bac-
teria have defects later in phagosome processing (Figure 2B).
To probe a requirement for peroxisomes in phagosome forma-

tion or maturation, we incubated GFP-SKL cells with E. coli
bioparticles that fluoresce when incorporated into early phago-
somes. A subset of peroxisomeswas observed to cluster around
phagosomes containing bioparticles (Figure 2C).
Transmission electron microscopy showed that cells infected

with bacteria formed vacuoles of varying size containing bacteria
and adjacent to large vesicular structures (Figure 2D, b) that were
not observed in uninfected cells (Figure 2D, a). Pex5-i and Pex7-i
cells had a low uptake of E. coli (Figure 2D, c and d), as evi-
denced by the low number of vacuoles in their cytoplasm. Higher
magnification images of infected control cells showed E. coli
cells within a large vacuole, presumably a phagosome, sur-
rounded by mitochondria and electron-dense round vesicles
with the morphological features of peroxisomes (Figure 2D, e).
Immunogold labeling with antibodies to PTS1 confirmed that
these vesicles were peroxisomes (Figure 2D, f).
Vector analysis of the movement of peroxisomes labeled with

GFP-SKL (green) indicated that peroxisomesmoved randomly in
uninfected cells (Figure S2E, a). In cells in close contact with a
single E. coli (red), peroxisomes moved preferentially toward
the E. coli cell and concentrated adjacent to it (Figure S2E, b).
In cells in contact with multiple E. coli cells, peroxisomes were
restricted in their movement and were observed to concentrate
adjacent to each E. coli cell (Figure S2E, c). These data suggest
a redistribution of peroxisomes toward sites of phagocytosis.

Peroxisomes Regulate H2O2 Upon Bacterial Infection
The clustering of peroxisomes around phagosomes (Figures 2C
and 2D, e and f) and the defects observed in lysosomematuration
in Pex5-i and Pex7-i cells (Figure 2B) suggested a role for perox-
isomes in phagosome formation and/ormaturation. Peroxisomes
are also a major producer and scavenger of ROS and reactive
nitrogen species (RNS), including hydrogen peroxide (H2O2) and
nitric oxide (NO) (Schrader and Fahimi, 2006). H2O2 and NO are
permeableanddiffusiblemolecules involved in inter- and intracel-
lular signaling during host defense in human (Bedard and Krause,
2007; Blander and Sander, 2012) and Drosophila (Buchon et al.,
2014; Foley and O’Farrell, 2003; Gonzalez et al., 2013).
We compared H2O2 amounts in uninfected and bacterially in-

fected control, Pex5-i and Pex7-i cells (Figure 3A). After 2 hr,
H2O2 amounts rose 10-fold in infected control cells relative to un-
infected cells. In Pex5-i cells, the amounts of H2O2 in uninfected
cells were higher than in uninfected control cells, and exposure
of Pex5-i cells to E. coli increased H2O2 amounts 2.5-fold relative
to uninfected Pex5-i cells at 2 hr. Similarly, uninfected Pex7-i
cells had higher amounts of H2O2 than uninfected control cells,
and H2O2 amounts in infected Pex7-i cells at 2 hr rose 4-fold
compared to uninfected Pex7-i cells, less than the 10-fold
change seen in infected control cells at 2 hr. When the 2 hr expo-
sure to bacteria was followed by a 4 hr incubation without bac-
teria, H2O2 amounts in control cells dropped, while H2O2

amounts remained elevated in Pex5-i and Pex7-i cells.
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Figure 2. Peroxisomes Associate with the Phagosome
(A) Indirect immunofluorescence detection of the early endosome marker Rab5 (green) showed no detectable changes in endosome number or morphology in

control, Pex5-i and Pex-7-i cells. Scale bar represents 10 mm.

(B) Indirect immunofluorescence detection of the lysosomal marker Lamp1 showed that Pex5-i and Pex7-i cells had reduced numbers of enlarged lysosomes

compared to control cells when infected with E. coli. Scale bar represents 10 mm. Histogram at left reports the average number of Lamp1-positive structures per

cell ± SD; histogram at right reports the average area (mm2 ± SD) of Lamp1-positive structures. Twenty cells of each genotype were measured for each analysis.

Statistical significance was determined using Student’s t test; **p < 0.01.

(C) S2 cells were incubated with pHrodo Red E. coli BioParticles that label sites of active phagocytosis. Peroxisomes (green) clustered around phagocytic

vesicles. Scale bar represents 10 mm.

(D) Electron microscopy of uninfected S2 cells (a) and of S2 (b), Pex5-i (c), and Pex7-i (d) cells infected with E. coli. Panel e shows a higher magnification of the

vacuolar structure seen in panel b. Panel f shows immunogold labeling of round, electron-dense vesicles with anti-PTS1 antibodies, confirming that these

structures are peroxisomes. Panels a-f are representative of multiple images (n = 5). Scale bars represent 2 mm (a-d), 1 mm (e), 500 nm (f). B, bacterium;

M, mitochondrion; P, peroxisome. Please see also Figure S2.
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ROS in cells was determined visually by staining with dihy-
droethidium (DHE). An increased DHE signal was observed
in control, Pex5-i and Pex7-i cells infected with E. coli compared
to uninfected cells (Figure 3B). Quantification indicated
increased ROS in infected cells (Figure 3C). ROS were 3-fold
greater in uninfected Pex5-i and Pex7-i cells than in uninfected
control cells and were similar in amount to ROS in infected con-
trol cells. The ROS in Pex5-i and Pex7-i cells increased upon
infection with E. coli and were elevated 4-fold or more to the
ROS in infected control cells. Our results are consistent with a
requirement for Pex5 and Pex7 in mediating ROS in the cellular
response to bacterial infection.
ROS at normal physiological amounts are necessary for cyto-

skeleton remodeling at phagocytic sites and for activation of im-
mune signaling, while an imbalance in ROS affects the assembly
of cortical actin and the ability of cells to phagocytose (Gonzalez
et al., 2013). IFC confirmed that an imbalance in ROS affected
phagocytosis, as control cells treated for 16 hr with 10 mM
H2O2 and then incubated with E. coli exhibited reduced internal-

A B

C D
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F

Figure 3. Peroxisomes Regulate H2O2 Turn-
over during Bacterial Infection
(A) Relative amounts of H2O2 in control, Pex5-i,

and Pex7-i cells after 2 and 6 hr infection from cells

infected with E. coli for 2 hr or infected with E. coli

for 2 hr followed by incubation in the absence of

E. coli for 4 hr (6 hr).

(B) Pex5-i and Pex7-i cells in contact with Rod-

shaped mCherry-E. coli showed elevated ROS

detected by DHE staining (red). Scale bar repre-

sents 10 mm.

(C) In uninfected or E. coli-infected control, Pex5-i,

and Pex7-i cells. ROS amounts in uninfected

control cells were normalized to 1. Values re-

ported represent the averages of 3 independent

experiments ± SD 2,000 cells of each genotype

under each condition were analyzed in each in-

dependent experiment.

(D) Percentage of E. coli cells attached to the

surface (membrane-bound) or internalized by cells

of the designated genotypes and conditions.

(E) Distribution of actin (green) in control cells

treated for 16 hr with 10 mM H2O2 was more

disorganized than in treatedCat-i cells. Scale bars

represent 10 mm.

(F) H2O2 amounts in clarified lysates of control,Act

> Pex5-i and Act > Pex7-i flies uninfected (!) or

infected (+) with Ecc15 cells for 6 hr (black box)

and from flies uninfected (!) or infected (+) with

Ecc15 cells for 6 hr followed by incubation in the

absence of Ecc15 for 10 hr (16 hr). Values reported

in (A), (C), and (D) are the averages of 3 indepen-

dent experiments ± SD. Statistical significance in

(A) and (C) was determined using Student’s t test;

**p < 0.01; *p < 0.05; ns = not significant. Statistical

significance in (D) was determined using two-way

ANOVA; ****p < 0.0001; ***p < 0.001; **p < 0.01;

*p < 0.05; ns = not significant. Please see also

Figures S2 and S3.

ization of bacteria similar to what was
observed in Pex5-i and Pex7-i cells (Fig-
ure 3D). Moreover, defects in actin orga-

nization were seen in H2O2-treated cells (Figure 3E). Cells with
reduced peroxisomal catalase (Cat-i), which converts H2O2 to
water and molecular oxygen, also exhibited defects in actin or-
ganization (Figure 3E) and reduced bacterial uptake (Figure 3D).
To investigate a link between peroxisomal ROS and phagocy-

tosis, we ectopically expressed a gene encoding catalase driven
by the Act5C promoter (Act-Cat) in Pex5-i and Pex7-i cells (Fig-
ure 3D), which were then infected with E. coli for 2 hr. Infected
Pex7-i cells expressingCat (Pex7-i; Act-Cat) exhibited increased
phagocytosis compared to infected Pex7-i cells, whereas
infected Pex5-i cells expressing Cat (Pex5-i; Act-Cat) phagocy-
tosed E. coli to the same extent as Pex5-i cells. Therefore, over-
expression of Cat could rescue the phagocytosis defect
observed in Pex7-i cells but not Pex5-i cells. This was not unex-
pected, as Pex5-i cells are compromised in the import of perox-
isomal proteins like catalase that are targeted by PTS1, while
Pex7-i cells are reduced for the receptor that recognizes proteins
targeted to the peroxisomal matrix by an unrelated PTS2 (Swin-
kels et al., 1991).
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We also reduced ROS in control, Pex5-i, and Pex7-i cells with
the ROS scavenger, sodium pyruvate, before infection with
E. coli. Pex5-i and Pex7-i cells treated with sodium pyruvate ex-
hibited increased internalization of E. coli relative to untreated in-
fected Pex5-i and Pex7-i cells (Figure 3D). Therefore, reducing
cellular ROS can compensate for the reduced bacterial uptake
observed in Pex5-i and Pex7-i cells.

Drosophila Requires Peroxisomes to Survive Infection
To ascertain whether Pex5 or Pex7 has a role in ROS-mediated
bacterial phagocytosis in adult flies, we depleted Pex5 and
Pex7 ubiquitously by expression of dsRNA transgenes via the
Act5C promoter. The efficiency of RNAi in each strain was
confirmed by qRT-PCR (Figure S2F). H2O2 amounts were
measured in 2- to 3-day-old flies infected for 6 hr with the
Gram-negative bacterium Erwinia carotovora (Ecc15). Oral infec-
tion with Ecc15 was used, as Act > Pex5-i and Act > Pex7-i flies
showed increased sensitivity to wounding when vehicle alone
was injected (Figures S3A-S3C). At 6 hr of infection, control
adults had approximately 10-fold higher amounts of H2O2 than
uninfected control flies (Figure 3F). H2O2 amounts in infected
control flies 10 hr after removal of the pathogen, i.e., at 16 hr,
were similar to uninfected control flies at 16 hr (Figure 3F).
When Act > Pex5-i flies were infected for 6 hr, the amounts of
H2O2 rose, but the ratio between infected versus uninfected an-
imals was only 2-fold and dropped to 1.5-fold after 16 hr (Fig-
ure 3F). The amounts of H2O2 in infected Act > Pex7-i flies at
6 hr also increased relative to uninfected siblings by 5.5-fold (Fig-
ure 3F). During acute infection of Act > Pex7-i flies, the amounts
of H2O2 dropped but remained 2-fold higher than in uninfected
Act > Pex7-i flies (Figure 3F) and almost 3-fold higher than in un-
infected control flies (Figure 3F). Together, these data show that
the metabolism of H2O2 in response to bacterial infection is
dependent on both Pex5 and Pex7.

To determine whether there is a role for peroxisomes in
response to chronic infection,Act > Pex5-i andAct > Pex7-i adult
flies were tested for their ability to survive chronic infection by
Ecc15 and E. coli. Uninfected Act > Pex5-i and Act > Pex7-i flies
did not show reduced viability compared to uninfected control
flies (Figure 4A). When infected with Ecc15, 50% of Act >
Pex5-i flies and 30% of Act > Pex7-i flies died after 4 days (Fig-
ure 4B). Act > Pex5-i and Act > Pex7-i flies infected with Ecc15
continued to die at a greater rate than control flies until day 7
post infection when all Act > Pex5-i and Act > Pex7-i flies were
dead (Figure 4B). Similarly, when infected with E. coli, 65% of
Act > Pex5-i flies and 75% of Act > Pex7-i flies died after
4 days, and Act > Pex5-i and Act > Pex7-i flies continued to
die at a greater rate than control flies until day 6 post infection
when allAct >Pex5-i andAct >Pex7-i flieswere dead (Figure 4C).
A requirement for peroxisomes in response to chronic infection
was not limited to infection with Gram-negative bacteria, as
Act > Pex5-i and Act > Pex7-i flies were more sensitive to infec-
tion with the Gram-positive bacterium Staphylococcus aureus
(Figure 4D) or the yeast Candida albicans (Figure 4E). Quantita-
tive assessment of the pathogen load of a microorganism ex-
tracted from flies showed that the load was greater for both
Act > Pex5-i and Act > Pex7-i flies compared to control flies
when infected with Ecc15 (Figure S3D), S. aureus (Figure S3E)
or C. albicans (Figure S3F). Thus, ubiquitous reduction of Pex5

or Pex7 makes adult flies more susceptible to infection by a va-
riety of pathogens.
To probe the contribution of peroxisomes in circulating hemo-

cytes to the immune response, Pex5 and Pex7 expression was
reduced in adult hemocytes by expression of dsRNA transgenes
via the hemocyte-specific Hml promoter. Similar to findings in
Act > Pex5-i and Act > Pex7-i flies (Figure 4B), Hml > Pex5-i
and Hml > Pex7-i flies showed increased sensitivity to infection
(Figure 4F) and increased bacterial load (Figure S3G). Therefore,
compromised peroxisomal function in hemocytes makes adult
flies more susceptible to bacterial infection.

Peroxisomes Regulate NO Turnover during Infection
Because NO has been linked to Drosophila bactericide capacity
(Foley and O’Farrell, 2003), we investigated whether peroxi-
somes function in regulating NO in cells. NO was measured in
control, Pex5-i and Pex7-i cells before and after infection with
E. coli. In control cells, NO increased "3-fold 3 hr after infection,
while infected Pex5-i and Pex7-i cells did not show a comparable
increase (Figure 4G), implicating peroxisomes in the regulation of
NO during infection.
To ascertain whether Pex5 or Pex7 plays a role in NO turnover

in adult flies, NO was measured in 2- to 3-day-old control, Act >
Pex5-i andAct > Pex7-i flies infected chronically (6 hr) with Ecc15
(Figure S3H). Infected controls had approximately 2.5-fold
higher amounts of NO compared to uninfected controls. In
contrast, overall amounts of NO did not change in infected Act
> Pex5-i flies or infected Act > Pex7-i flies versus their uninfected
counterparts. Together, these data show that NO metabolism in
response to bacterial infection is dependent on both Pex5
and Pex7.

p38-MAPK Signaling Is Affected by Depletion of Pex5
or Pex7
Activation of the conserved p38MAPK pathway, involved in host
defense in bothmammals andDrosophila (Chen et al., 2010), can
be measured by antibody detection of phosphorylation of p38 at
amino acids T180/Y182. IFC revealed that the percentage of
control cells positive for phosphorylated p38 (P-p38) doubled
90 min after E. coli infection; however, there was little change
in the percentages of Pex5-i and Pex7-i cells positive for P-p38
upon infection (Figure 4H). The percentage of dead cells was
higher in both infected and uninfected Pex5-i and Pex7-i cells
compared to their respective controls. Our results are consistent
with roles for peroxisomes in influencing signaling from the p38
MAPK pathway in response to bacterial infection.

Peroxisomes Are Required for Induction of the
Antimicrobial Peptide Response
ROS imbalance can activate the p38MAPK pathway with effects
on the inducible innate immune response in fly (Chen et al., 2010;
Foley and O’Farrell, 2003) and in mammals (Muralidharan and
Mandrekar, 2013). Two signaling pathways regulate this
response to bacterial and fungal infection in Drosophila: the
Toll pathway and the immunodeficiency (IMD) pathway (Lemaitre
and Hoffmann, 2007). The Toll and IMD pathways induce sys-
temic production of overlapping, yet distinct, sets of antimicro-
bial peptides (AMP) in response to infection with Gram-positive
or Gram-negative bacteria, respectively (Buchon et al., 2014;
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Figure 4. Pex5 and Pex7 Mediate the Immune Response to Bacterial Infection in Flies and Cells
(A–E) Survival of control, Act > Pex5-i and Act > Pex7-i flies fed 5% sucrose (A) or under chronic oral infection with Ecc15 (B), E. coli (C), S. aureus (D), or

C. albicans (E).

(F) Survival of control,Hml > Pex5-i andHml > Pex7-i flies injected with PBS or Ecc15. For (A)–(F), n = 50 for each genotype in a single experiment. Values reported

in (A)–(F) represent the averages of 3 independent experiments ± SD. Statistical significance was determined using the log-rank test (Mantel-Cox); ***p < 0.001;

**p < 0.01; *p < 0.05; ns = not significant.

(G) NO amounts per mg protein in clarified lysates of control, Pex5-i, and Pex7-i cells. Lysates were prepared from uninfected cells or cells infected with E. coli

for 2 hr.

(H) Quantification of phosphorylated p38 (P-p38) in control, Pex5-i, and Pex7-i cells uninfected (!) or infected (+) with E. coli for 2 hr. Values reported in (G) and (H)

represent the averages of 3 independent experiments ± SD. Statistical significance in (G) was determined using Student’s t test; **p < 0.01; ns = not significant.

Please see also Figure S3.
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Lemaitre and Hoffmann, 2007). Infection of control cells with
Ecc15 induced expression of the Drosophila AMP genes Dpt
(Figure 5A) and Att (Figure 5B) genes, with the greatest increase
seen 4 hr after infection. AMP gene transcription under Ecc15

stimulus was suppressed after the infection was controlled (Fig-
ures 5A and 5B; 360 min). Pex5-i and Pex7-i cells infected with
Ecc15 showed no induction of Dpt or Att expression (Figures
5A and 5B).
Dpt and Att are regulated by the Drosophila NF-kB homolog,

Relish (Rel), which translocates to the nucleus upon cell infection
(Lemaitre and Hoffmann, 2007). RNAi-mediated reduction of Rel
expression impaired AMP gene expression in response to Ecc15
infection (Figure S4A). IFC quantification of Rel localization (Fig-
ure 5C) showed almost twice as many control cells with nuclear
Rel 30 min after infection (Figure 5C). In contrast, the number of
cells with nuclear Rel decreased after infection of both Pex5-i
and Pex7-i cells (Figure 5C), confirming downregulation of im-
mune signaling.
We determined whether reduction in AMP gene expression in

Pex5-i and Pex7-i cells (Figure 5) is linked to the IMD pathway by
treating cells with activators of the IMD pathway. The IMD
pathway can be activated by binding of the peptidoglycan
recognition protein LC (PGRP-LC) receptor to polymeric pepti-
doglycan (PGN) (Lemaitre and Hoffmann, 2007). Treatment of
cells with polymeric PGN or heat-inactivated bacteria containing
polymeric PGN in their cell wall resulted in increasedDpt expres-
sion in control, Pex5-i, and Pex7-i cells (Figure 6A). However,
treatment of control, Pex5-i, and Pex7-i cells with tracheal cyto-
toxin (TCT), a bacterially secreted monomeric PGN that binds
PGRP-LC and also the intracellular peptidoglycan recognition
protein LE (PGRP-LE) receptor to activate the IMD pathway
(Kaneko et al., 2006), led to increased Dpt expression in control
cells but no increased expression in Pex5-i and Pex7-i cells
(Figure 6B). Our results are consistent with a scenario in which
the innate immune response to monomeric PGN requires
peroxisomes.

Peroxisomes Are Needed for Induction of the AMP
Response in Adult Drosophila
Given the reduced AMP response in Pex5-i and Pex7-i cells
when challenged with Ecc15 and with TCT, we next deter-
mined whether there was a similar requirement for peroxi-
somes for generating the AMP response in adult flies. Flies
were infected by thoracic injection of pathogen, as permissive
short-term experimental analysis was not affected by sensi-
tivity of Act > Pex5-i flies to wounding. Infection with Ecc15
induced Att and Dpt expression in control flies 6 hr post-infec-
tion (Figure 6C). However, neither Act > Pex5-i nor Act >
Pex7-i flies showed increased Att or Dpt expression 6 hr
post-infection (Figure 6C). The gene for Drosomycin (Drs) en-
codes an AMP that is induced by Gram-positive bacteria and
fungi and, as expected, did not show increased expression in
Ecc15-infected animals of all three genotypes (Figure 6C). In-
jection of Hml > Pex5-i and Hml > Pex7-i flies resulted in a
reduced induction of Dpt expression compared to control he-
mocytes (Figure 6D). These data are consistent with the need
for peroxisomes in hemocytes for full induction of Dpt expres-
sion in response to infection of the fly by Gram-negative
bacteria.
The fat body also contributes to the Drosophila immune

response (Lemaitre and Hoffmann, 2007). We examined Dpt
expression in flies in which Pex5 (Cg > Pex5-i) and Pex7 (Cg >
Pex7-i) transcripts were specifically reduced in the fat body by

A

B

C

Figure 5. Pex5 and Pex7 Are Required for Induction of Dpt and Att
Expression upon Infection
(A) Quantification of Dpt induction in control, Pex5-i, and Pex7-i cells after

infection with Ecc15.

(B) Quantification of Att transcript over time in control, Pex5-i and Pex7-i cells

after infection with Ecc15.

(C) Quantification of the distribution of Rel between nucleus and cytoplasm in

control, Pex5-i, and Pex7-i cells uninfected (!) or infected (+) with Ecc15 for

2 hr. Values reported in (A) and (B) are the averages of 4 independent

experiments ± SD. Statistical significance was determined using Student’s

t test; ***p < 0.001; **p < 0.01; *p < 0.05; ns = not significant. Values reported in

(C) are the averages of 3 independent experiments ± SD. Please see also

Figures S3 and S4.
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RNAi driven by theCg-GAL4 driver. The induction ofDpt expres-
sion in Cg > Pex5-i and Cg > Pex7-i flies was lower than that of
control flies (Figure 6E). Thus, peroxisomes are required for
modulating the AMP gene response to bacterial infection in
both hemocytes and the fat body.
We tested whether the defect in immune signaling in Pex5-i

and Pex7-i cells might be due to reduced uptake of bacteria
by cells by comparing Dpt expression in uninfected or
Ecc15-infected cells treated with the phagocytosis inhibi-
tors cytochalasin B and latrunculin B (Figure 6F). Untreated
and inhibitor-treated cells exhibited a 7-fold and 10-fold in-
duction of Dpt expression, respectively (Figure 6F), demon-
strating that reduced bacterial uptake does not inhibit the
AMP response.

PeroxisomesAreRequired for Toll-Dependent Induction
of the AMP Response
Gram-positive bacteria and fungi activate the Drosophila im-
mune response through the Toll pathway (Lemaitre and
Hoffmann, 2007). Whereas Dpt expression is induced via the

IMD pathway, Drs expression is induced by the Toll pathway
(Lemaitre and Hoffmann, 2007). S. aureus is known to activate
the Toll pathway (Liu et al., 2016). To test whether peroxi-
somes are involved in the Toll pathway-mediated immune
response, we infected flies with S. aureus, and Drs expression
was measured. In control flies, Drs was induced 150-fold 6 hr
after infection (Figure 6G). A comparable induction of Drs was
not observed in Act > Pex5-i and Act > Pex7-i flies (Figure 6G),
suggesting that peroxisomes are required for the Toll-medi-
ated immune response. The Wnt pathway is a known
downregulator of the Toll pathway acting in a negative feed-
back loop through the transcription of Wnt oncogene analog
4 (Wnt4) upon activation of Dorsal, a Drosophila homolog of
mammalian NF-kB (Gordon et al., 2005). Wnt4 transcription
was upregulated "4-fold after S. aureus infection of control
flies but not of infected Act > Pex5-i and Act > Pex7-i flies
(Figure 6H), showing that inhibition of the Toll pathway
caused by peroxisome dysfunction likely occurs upstream of
transcriptional activation of the Toll downstream effector,
Dorsal.

A B

C D

E F

G H

Figure 6. Pex5 and Pex7 Are Required for
AMP Gene Induction in Response to Infec-
tion with Bacteria or Yeast
(A) Quantification of Dpt transcript in control,

Pex5-i, and Pex7-i cells after treatment with poly-

meric PGN for 3 hr or infection with heat-in-

activated E. coli for 2 hr.

(B) Quantification of Dpt mRNA in control, Pex5-i,

and Pex7-i cells after treatment with TCT for 12 hr.

(C) Quantification of Att, Dpt and Drs mRNA in

control, Act > Pex5-i and Act > Pex7-i flies 6 hr

after injection of Ecc15.

(D) Quantification of Dpt transcript in hemocytes

isolated from flies of the designated genotypes

6 hr after infection with Ecc15.

(E) Quantification of Dpt mRNA in the fat body of

flies of the designated genotypes 6 hr after infec-

tion with Ecc15.

(F) Quantification of Dpt mRNA in Ecc15-infected

cells untreated or treated with cytochalasin B and

latrunculin B. The changes in Dpt mRNA amounts

in infected cells are reported relative to DptmRNA

amounts in their uninfected counterparts.

(G) Quantification of Drs mRNA in control, Act >

Pex5-i, and Act > Pex7-i male flies after infection

with S. aureus for 6 hr.

(H) Quantification of Wnt4 mRNA in control, Act >

Pex5-i, and Act > Pex7-i flies after infection with

S. aureus for 4 hr. For all samples reported in (A)

and (B), (C)–(E), and (G) and (H), transcript

amounts were normalized to corresponding unin-

fected samples of the same genotypes. Values

reported in (A), (B), (F), and (G) are the averages of

4 independent experiments ± SD, and in (C)–(E)

and (H) are the averages of 3 independent

experiments ± SD. Statistical significance was

determined using Student’s t test; ***p < 0.001;

**p < 0.01; *p < 0.05; ns = not significant. Please

see also Figures S3 and S4.
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Decreased H2O2 and Increased NO Amounts Partially
Restore Induction of the AMP Response
To investigate a link between peroxisomal ROS and the AMP
response to infection, we ectopically expressed the Cat gene
(Act > Cat) encoding peroxisomal catalase in control, Pex5-i,
and Pex7-i cells. Ecc15-infected control and Pex7-i cells ex-
hibited a 6-fold and 7-fold, respectively, induction ofDpt expres-
sion relative to uninfected counterparts, whereas Pex5-i cells ex-
hibited a reduced induction (Figure 7A). In contrast, reducingCat
expression (Cat-i) eliminated the induction of Dpt expression in
response to infection (Figure S4B). Control cells pretreated
with H2O2 for 1 hr exhibited a normal increase in Dpt expression
upon infection. If cells were exposed to H2O2 for 16 hr, this in-
crease in Dpt expression was not observed (Figure S4C). There-
fore, chronically high amounts of H2O2 inhibited Dpt expression
in response to infection, while overexpression of catalase, which
consumes H2O2, could rescue the induction of Dpt expression in
response to infection in Pex7-i but not Pex5-i cells. This was not
unexpected, because Pex5-i but not Pex7-i cells were compro-
mised in the peroxisomal import of PTS1 proteins like catalase.
Because Pex5-i cells fail to import catalase, we chemically

reduced ROS in cells by addition of the ROS scavenger, sodium
pyruvate. Although infected Pex5-i cells treated with sodium py-
ruvate exhibited greater overall induction of Dpt expression
relative to untreated infected Pex5-i cells (Figure S4E), this
rescue of Dpt expression by sodium pyruvate was only partial
when compared to infected treated control cells (Figure S4D).
Therefore, reducing cellular ROS can compensate only partially
the reduction in the AMP response to bacterial infection in
Pex5-i cells.
NO has also been linked to the bactericide capacity of

Drosophila (Foley and O’Farrell, 2003). Cells and adult flies with
impaired peroxisomes did not exhibit increased NO upon infec-
tion with Ecc15 (Figures 4G and S3H). We investigated whether
NO could activate the immune response in flies without peroxi-
somes by evaluating the effects on Dpt expression of giving
the NO donor, S-Nitroso-N-acetylpenicillamine (SNAP), to con-
trol and Act > Pex5-i adult flies. Dpt expression was followed
using a reporter construct in which GFP expression is controlled
by the Dpt promoter (Dpt-GFP). No GFP was observed in unin-
fected control or Act > Pex5-i flies (Figures 7B and 7C). 85% of
control flies infected with Ecc15 produced GFP (Figures 7B
and 7C) within 6 hr of infection, while only about 5% of infected

Act > Pex5-i flies produced GFP (Figures 7B and 7C). Treatment
with SNAP induced Dpt expression in uninfected control flies,
with 45% of flies produced GFP in the presence of SNAP versus
no flies in its absence (Figure 7C), while treatment with SNAP
increased the percentage of infected Act > Pex5-i flies with
GFP to about 70% from 5% (Figures 7B and 7C). Our data
show that peroxisomes regulate induction of Dpt expression in
response to Gram-negative bacterial infection by regulating
both H2O2 and NO.

Pex7 Is Essential for Phagocytosis by Murine
Macrophages
We examined whether peroxisomes are required for phagocy-
tosis by mammalian macrophages by comparing the ability of
bone marrow macrophages from homozygous Pex7 hypomor-
phic (Pex7hypo/hypo) mice (Braverman et al., 2010) and homozy-
gous Pex7 null (Pex7!/!) mice and their heterozygous littermates
to phagocytose fluorescent E. coli (Figures 7D–7F and 7I).
Macrophage differentiation wasmonitored by IFC of themarkers
CD11b and F4/80 (Figures S5A-S5D). The Pex7 mutations in
each mouse strain were confirmed by reductions in Pex7 tran-
script and plasmalogens (Braverman et al., 2010). Immunofluo-
rescence microscopy showed that thiolase, which depends on
Pex7 for its targeting to peroxisomes (Braverman et al., 1997),
localized to puncta characteristic of peroxisomes in Pex7+/hypo

macrophages (data not shown) and Pex7+/! macrophages, but
exhibited a diffuse fluorescence pattern characteristic of the
cytosol in Pex7!/! macrophages (Figure S5E).
Pex7!/! macrophages exhibited a 25%–30% reduction in

internalization of bacteria compared to Pex7+/! macrophages
(Figure 7I); this reduced internalization by Pex7!/!macrophages
was similar to the internalization by Pex7+/! macrophages
treated with cytochalasin B (Figure 7I). Our results demonstrate
that peroxisomes are required by murine macrophages for
phagocytosis of bacteria.

Peroxisome-Derived Lipids Influence Bacterial
Phagocytosis by Murine Macrophages
Lipids have important roles in phagocytosis. Phosphatidylinosi-
tol-4,5-bisphosphate (PtdIns(4,5)P2) activates actin assembly at
phagosome sites in infected macrophages (Anes et al., 2003),
and docosahexaenoic acid (DHA) increases the rate of phagocy-
tosis in macrophages and neutrophils (Anes et al., 2003;

Figure 7. Murine Macrophages Mutant for Pex7 Show Defects in Bacterial Uptake
(A) Quantification ofDptmRNA in control, Pex5-i, and Pex7-i cells overexpressingCat and either uninfected (!) or infected (+) for 3 hr with Ecc15. Values reported

are the averages of 4 independent experiments ± SD. Statistical significance was determined using Student’s t test; ***p < 0.001; **p < 0.01; *p < 0.05.

(B) NO signaling activates expression of aDpt gene reporter construct (Dpt-GFP). Uninfected control flies did not express theDpt-GFP and exhibited only a weak

green signal arising from autofluorescence (extreme left). Flies infected with Ecc15 showed a strong GFP signal arising from induced Dpt-GFP activity (second fly

from left). A GFP signal was not observed in infected Act > Pex5-i flies (second fly from right), demonstrating the requirement for peroxisomes for activation of

Dpt-GFP. The NO donor SNAP induced a GFP signal in infected Act > Pex5-i flies (extreme right), demonstrating NO regulation of Dpt-GFP expression.

(C) Percentage of flies expressing GFP 6 hr following the designated treatments. Values reported represent the averages of 3 independent experiments ± SD.

(D and E) Representative outputs from IFC showing the percentage of Pex7+/! macrophages (D) or Pex7!/! macrophages (E) that internalized fluorescent E. coli

(gate R4) or bound E. coli on their surface (gate R5).

(F) Upper panels, representative images of a macrophage that has bound but has not engulfed an E. coli (gate R5); lower panels, representative images of a

macrophage that has engulfed an E. coli (gate R4).

(G and H) Representative outputs of IFC showing the percentage of Pex7!/!macrophages that internalized E. coli (gate R4) or bound E. coli on their surface (gate

R5) after 24 hr treatment with PtdIns(4,5)P2 (G) or DHA (H).

(I) Percentage of macrophages of each genotype and treatment that bound E. coli to their surface (membrane-bound) or internalized E. coli. Values reported

represent the averages of 2 independent experiments ± SD. Statistical significance was determined using Student’s t test; ***p < 0.001; **p < 0.01; *p < 0.05.

Please see also Figures S4 and S5.
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Paschoal et al., 2013). Phosphatidylinositols and DHA are made
inmammalian peroxisomes (Jeynov et al., 2006;Waterhamet al.,
2016). We treated Pex7hypo/hypomacrophages with PtdIns(4,5)P2

or DHA and tested their ability to engulf bacteria. IFC revealed
that PtdIns(4,5)P2 and DHA enhanced the ability of Pex7hypo/hypo

macrophages to engulf bacteria (Figures 7G–7I). Our data sug-
gest that peroxisomal lipids influence phagosomal activity.

We also performed a genome-wide transcriptional compari-
son of uninfected and bacterially infected S2R+ cells that
revealed transcriptional upregulation of a number of genes en-
coding enzymes involved in lipid metabolism (F.D., unpublished
data). We validated these findings for a subset of genes by
qRT-PCR and confirmed that the transcriptional upregulation
of these genes was not observed in infected Pex5-i or infected
Pex7-i cells (Figure S5F), suggesting that depletion of Pex5 or
Pex7 transcripts compromises the ability of cells to mount an
appropriate peroxisomal response to bacterial infection. Our
data provide a segue to further investigations of the require-
ments of lipids and lipid metabolism in macrophagic resolution
of infection.

We have demonstrated that peroxisomes are required to
resolve infection through innate immune signaling. Peroxisome
dysfunction results in an impaired response to microbial chal-
lenge that reduces cell and organism survival.

DISCUSSION

We earlier showed that peroxisomal proteins in Drosophila act
analogously to their yeast and human counterparts and provided
validation of Drosophila as a model to study the requirement for
peroxisomes in the development and physiology of complex or-
ganisms (Baron et al., 2016; Mast et al., 2011). Increasing
numbers of important metabolic functions are being attributed
to peroxisomes in addition to their long recognized roles in
anabolic and catabolic reactions of lipid metabolism (Wanders
and Waterham, 2006; Waterham et al., 2016). Lipids are
emerging as factors involved in innate immune defense, as sys-
temic lipid changes accompany the acute phase of the macro-
phage response, and the de novo synthesis of bioactive lipids
is needed for the resolution of inflammation (Neyen and Gordon,
2014). Our findings identified a previously unexplored function
for peroxisomes in innate immunity.

Reduction in Pex5, Pex7, and Pex13 expression compromised
phagocytosis of bacteria by Drosophila S2 cells and adult flies.
Phagocytosis is critical for development and immunological re-
sponses that mediate host defense (Aderem and Underhill,
1999; Gordon, 2016; Stuart and Ezekowitz, 2008). An earlier
study had shown a requirement for Pex7 in the phagocytosis
of C. albicans by S2 cells (Stroschein-Stevenson et al., 2006);
however, no mechanistic link between Pex7 and phagocytosis
was made. Since reduction in the transcript amounts of Pex5,
Pex7, and Pex13 produced a similar reduction in bacterial up-
take, our results are consistent with a scenario in which the
peroxisome and its activities in toto, rather than a peroxisome-in-
dependent activity of Pex5, Pex7, or Pex13, contribute to
phagocytosis.

The cytoskeleton rearranges during formation of the phago-
some (Stuart and Ezekowitz, 2008). Our results showed that
peroxisome activity is required for reorganization of the cytoskel-

eton involved in forming the phagocytic cup and that reduced
Pex5 or Pex7 expression results in a disorganized actin network
and an altered distribution of the actin-nucleating protein, SCAR.
Actin remodeling defects are a common feature of primary
immunodeficiency disorders in which cell migration toward
the site of infection or inflammation is affected (Moulding
et al., 2013).
We noted that peroxisomes were often juxtaposed to phago-

somes. A study of rat macrophages had suggested that peroxi-
somes discharge catalase into phagosomes (Eguchi et al.,
1979). However, given our findings, it is likely that peroxisomes
are involved in mediating the organization of the phagosome,
progression of phagocytosis, and activation of immunity through
ROS and RNS modulation. Peroxisomes are important pro-
ducers and scavengers of ROS and RNS (Schrader and Fahimi,
2006). ROS-mediated host defense was previously seen as a
direct microbicidal activity, but recently ROS were shown to
have important roles in the activation of immune cells, suppres-
sion of the immune response, and rearrangement of the cyto-
skeleton for the progression of phagocytosis (Gonzalez et al.,
2013; Lam et al., 2010; Yang et al., 2013. ROS production by in-
fected cells would need to be under tight control to prevent
extraneous damage to surrounding tissue. Such tight regulation
was observed previously in mammals (Sareila et al., 2011). We
showed that reduction in Pex5 or Pex7 expression impaired
the normal ROS response to bacterial infection by S2R+ cells,
primary hemocytes, and flies. The RNS response of Pex5-i and
Pex7-i cells was also compromised. The changes in ROS and
RNS in Pex5-i and Pex7-i cells are most likely the result of
abnormal peroxisomal function, perhaps with respect to the per-
oxisomes’ prominent role in lipid metabolism. Lipid has been
shown to signal RNS production during infection (Anes et al.,
2003), and oxidized lipids, byproducts of the phagosome oxida-
tive burst, activate nuclear receptors that orchestrate lipid ho-
meostasis and cross regulate NF-kB-driven immune responses
(Neyen and Gordon, 2014). The deregulation in ROS and RNS
homeostasis that is observed upon infection of Pex5-i and
Pex7-i cells implicates peroxisomes in the host response to
infection through their regulation of the actin network to mediate
phagocytosis and through their mediation of intracellular
signaling pathways.
The Toll and IMD pathways control the inducible immune

response of Drosophila to bacterial and fungal infection and
initiate a NF-kB signaling cascade that controls the production
of distinct sets of AMPs (Lemaitre and Hoffmann, 2007). The
observed reduction of AMP gene expression in Pex5-i and
Pex7-i cells in response to infection with Gram-negative bacteria
or fungi supports a role for peroxisomes in regulating AMP gene
expression through the IMD pathway. Time-course experiments
excluded the possibility that the response of the IMD pathway
was simply delayed in infected Pex5-i and Pex7-i cells.
Our study showed that peroxisomes modulated TCT-acti-

vated but not polymeric PGN-activated IMD signaling cascade.
Although TCT and polymeric PGN activate the same signaling
cascade, their kinetics of activation and resolution of the immune
response are different. Given that endocytosis regulates the IMD
pathway response to polymeric PGN (Neyen et al., 2016), perox-
isomes could be involved in modulating the endosomal vesicular
trafficking that resolves the inflammation signaling elicited by
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TCT. Additionally, the influence of peroxisomes on the induction
of AMP gene expression was not limited to the IMD pathway,
since the absence of functional peroxisomes also altered
expression of AMP genes activated specifically by the Toll
pathway. How peroxisomes affect the expression of AMP genes
regulated by the Toll pathway is uncertain at this time.
Peroxisomes likely generate signals that mediate the cytoskel-

etal rearrangement required for phagocytosis. In mammalian
macrophages, phosphatidylinositol-4-phosphate and phospha-
tidylinositol-4,5-bisphosphate activate actin assembly at sites of
phagosome formation (Anes et al., 2003). Phosphatidylinositols
are made in mammalian peroxisomes (Jeynov et al., 2006).
Also, ether lipids and complex lipids like ceramide, sphingosine,
DHA and arachidonic acid have potent and highly complex
effects on immune cells, including inhibitory and stimulatory ef-
fects on the actin cytoskeleton (Anes et al., 2003). The amounts
of these complex lipids are altered in patients with peroxisome
biogenesis disorders (Braverman and Moser, 2012; Wanders
and Waterham, 2006; Waterham et al., 2016). A lack of peroxi-
somes could be envisioned to result in compromised cellular
lipid homeostasis and altered lipid species that signal for for-
mation of the phagosome. Our data showed that DHA and
phosphatidylinositol-4,5-bisphosphate can rescue phagocy-
tosis in Pex7 mutant murine macrophages. We also observed
that bacterial infection of Drosophila S2R+ cells induced the
expression of a number of genes encoding enzymes involved
in lipid metabolism; this induction response was absent in
Pex5-i and Pex7-i cells. Future studies analyzing the lipid profiles
of uninfected and infected Drosophila and mammalian cells
should aid in identifying the lipid species required to trigger
phagocytosis and initiate immune signaling.
In closing, we have provided functional and mechanistic evi-

dence for a requirement for peroxisomes for microbe-mediated
phagocytosis in macrophages of Drosophila and mouse, which
are evolutionarily separated by 900 million years. Peroxisomes
act to eliminate amicrobial infection bymodulating the canonical
innate immunity pathways through ROS and RNS signaling and
the activation of the stress response kinase p38. Impaired perox-
isomal function reduces organismal survival to infection and re-
veals a previously unknown requirement for peroxisomes in
modulating signaling pathways that trigger phagocytosis and
activate innate immunity. Our findings, together with earlier find-
ings elucidating a role for peroxisomes in inducing antiviral
factors (Dixit et al., 2010), demonstrated that peroxisomes serve
as critical subcellular hubs that promote immune responses in
animals.
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KEY RESOURCES TABLE

REAGENT or RESOURCE SOURCE IDENTIFIER

Antibodies

Mouse monoclonal anti Relish The Developmental Studies

Hybridoma Bank

C 21F3

Mouse monoclonal anti SCAR The Developmental Studies

Hybridoma Bank

P1C1-SCAR

Rabbit polyclonal anti SKL Rachubinski U of A NA

Rabbit polyclonal anti thiolase Rachubinski U of A NA

Rabbit polyclonal anti P-p38 Cell Signaling (9211)

Rabbit polyclonal anti-Rab5 Abcam ab31261

Rabbit polyclonal anti-Lamp1 Abcam ab30687

Mouse anti- CD11b BioLegend M1/70

Mouse anti- F4/80 BioLegend BM8

Bacterial and Virus Strains

mCherry-expressing E. coli Pukatzki Stefan, U of A NA

C. albicans Johnson Alexander, UCFS NA

S. aureus ATCC ATTC 25923

Ecc-15 (2141) Lemaitre Bruno, EPFL NA

Chemicals, Peptides, and Recombinant Proteins

cytochalasin B Sigma C2743-200UL

latrunculin B Cayman Chemical CAS No 76343-94-7

PtdIns(4,5)P2 Sigma P7115-500UG

DHA Sigma D2534-25MG

PGN InvivoGen PGN-EB

Critical Commercial Assays

Griess reagent Sigma G4410-10G

Amplex Red Hydrogen Peroxide/Peroxidase Assay Kit Thermo Fisher A22188

DHE Thermo Fisher D11347

sodium pyruvate Sigma P2256-10MG

Celltracker Blue Thermo Fisher C12881

Experimental Models: Cell Lines

Drosophila melanogaster S2R+ DGRC Stock Number: 150

Drosophila melanogaster S2 expressing GFP-SKL DGRC Stock Number: 197

Mouse: Bone marrow derived macrophages from B6;129S-Pex7hypo Braverman, Mcgill NA

Mouse: Bone marrow derived macrophages from B6;129S-Pex7- (null

allele)

Braverman, Mcgill NA

Experimental Models: Organisms/Strains

Drosophila melanogaster: RNAI lines y1 v1; P{TRiP.HMC04009}attP40 Bloomington Drosophila Stock Center #55322

Drosophila melanogaster: RNAI line w1118; P{GD14972}v42332 VDRC v42332

hml-GAL4, UAS-GFP, Dpt-GFP Foley, U of A NA

CRQGAL4, UAS-GFP Foley, U of A NA

Act5C-GAL4/CyO-Act5C-GFP King-Jones, U of A NA

Oligonucleotides

Rpl23-F 50GACAACACCGGAGCCAAGAACC Simmonds, U of A (this paper) NA

Rpl23-R 50GTTTGCGCTGCCGAATAACCAC Simmonds, U of A (this paper) NA

Att-F 50AGTCACAACTGGCGGAC Simmonds, U of A (this paper) NA
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CONTACT FOR REAGENT AND RESOURCE SHARING

Further information and requests for resources and reagents should be directed to and will be fulfilled by the Lead Contact, Andrew
Simmonds (andrew.simmonds@ualberta.ca).

EXPERIMENTAL MODELS AND SUBJECT DETAILS

Fly Stocks, Husbandry, and Infection
Stocks
Pex5 dsRNA expressing lines y1 v1;P{TRiP.HMC04009}attP40 andw1118;P{GD14972}v42332were from theBloomingtonDrosophila
Stock Center (BDSC) and the Vienna Drosophila Resource Center (VDRC), respectively. The Pex7 dsRNA expressing line
P{KK102648}VIE-260B was from VDRC. The fat body driver, Cg-GAL4, line w1118; P{Cg-GAL4.A}2 was from BDRC. The lines
Hml-GAL4, UAS-GFP, and Dpt-GFP and CRQGAL4, UAS-GFP were gifts from Dr. Edan Foley, University of Alberta. The lines
Act5C-GAL4/CyO and UAS-GFP were gifts from Dr. Kirst King-Jones, University of Alberta.
Husbandry
Drosophila lines were maintained at 25#C on standard BDSC corn meal medium. The age of the flies, when relevant, is specified.
Infection
For oral infection, flies were cultured on filter paper soaked in 5% sucrose or 5% sucrose containing S. aureus, Ecc15, E. coli, or
C. albicans (all OD600 = 200). Flies were transferred to fresh vials every 2 days, and the number of dead flies was determined daily.

Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Att-R 50TGTTGAATAAATTGGCATGG Simmonds, U of A (this paper) NA

Dpt-F 50ACCGCAGTACCCACTCAATC Simmonds, U of A (this paper) NA

Dpt-R 50ACTTTCCAGCTCGGTTCTGA Simmonds, U of A (this paper) NA

Drs-F 50GACTTGTTCGCCCTCTTCG Simmonds, U of A (this paper) NA

Drs-R 50CTTGCACACAGACGACAG Simmonds, U of A (this paper) NA

Pex5-F 50AAATGCGAAGACATGGAACC Simmonds, U of A (this paper) NA

Pex5-R 50TGTAACGCACACGGATGAAG Simmonds, U of A (this paper) NA

Pex7-F 50TCGAAATAGCCAGGCCATCAAG Simmonds, U of A (this paper) NA

Pex7-R 50AAGGAACCGAAGACAAGGACTC Simmonds, U of A (this paper) NA

Wnt4-F 50TTTGCCATCACATTCTTCATGGG Simmonds, U of A (this paper) NA

Wnt4-R 50GGGTGTACTGGTAGTAGCTCA Simmonds, U of A (this paper) NA

bgm-F 5ʹAGCACTACATGGTGAGTCAAGG Simmonds, U of A (this paper) NA

Bgm-R 5ʹGTAAGGACGCGATCGAAGC Simmonds, U of A (this paper) NA

FAR1-F 5ʹGCGGGACGTAGTGTCTTCAT Simmonds, U of A (this paper) NA

FAR1-R 5ʹGCAGCAACTTCTCCACCAGT Simmonds, U of A (this paper) NA

ACOX1-F 5ʹCCGTGAAGGATGTGCTCTTT Simmonds, U of A (this paper) NA

ACOX1-R 5ʹ-GCTGTTAATCCGGCTCTGG Simmonds, U of A (this paper) NA

FarO-F 5ʹ-CCAGTAATAGTGTATCGTCCTTCCA Simmonds, U of A (this paper) NA

FarO-R 5ʹ-CAAGGATGGCGAGAATCC Simmonds, U of A (this paper) NA

wat-F 5ʹ-AGCCACTCCAATCCAATCC Simmonds, U of A (this paper) NA

wat-R 5ʹ-TCCATCTCGGACGGATAAAT Simmonds, U of A (this paper) NA

Recombinant DNA

pAWR-Catalase Baron et al., 2016 NA

Software and Algorithms

IDEAS software Millipore NA

Imaris 8.3.1 Bitmap NA

MegaView III Soft Imaging System Olympus NA

FIJI/imageJ software

GraphPad 6 Prism NA
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For infection by microinjection, flies were injected into the thorax using 1-mm internal diameter, thin-walled glass needles pulled
with a P-97 Flaming-Brown micropipette puller (Sutter Instrument) mounted to a PV830 microinjector and needle positioner (World
Precision Instruments). Each fly was injected with 4 nL of Ecc15 (OD600 = 200) in PBS or PBS alone (control). Injected flies were trans-
ferred to 29#C, and the number of dead flies was determined every 2 days.
To generate survival curves for flies with RNA interference of Pex genes exclusively in hemocytes (Hml-driven interference), adult

flies were anesthetized with CO2 and infected by being pricked in the thorax with a thin needle that had been dipped into a bacterial
working solution. For Dpt-GFP expression, Act > Pex5-i flies were first fed food containing 15 mM SNAP (Sigma-Aldrich) for 2 hr
before anesthetization and infection with bacteria by pricking. Survival experiments were done at 29#C with 20-30 flies tested for
each group. Surviving flies were transferred daily to fresh vials and counted.

Pex7 Mutant Mice
The Pex7mutant mouse strains used were B6;129S-Pex7hypo (hypomorphic allele) (Braverman et al., 2010) and B6;129S-Pex7- (null
allele) created from Pex7hypo after deletion of exon 3 using the flanking loxP sites and the general Cre deleter strain, Tg(CMV-cre)
1Cgn. Mice used for this experiment were Pex7+/+, Pex7!/!, Pex7+/hypo and Pex7hypo/hypo. Pex7 heterozygous hypomorphic, homo-
zygous hypomorphic, heterozygous null, and homozygous null mutant strains exhibited reduced Pex7 transcript and reduced
plasmalogens, whose synthesis is dependent on PTS2 protein import into peroxisomes (N.E.B., unpublished data). Colonies were
maintained as stable inbred lines in the C57B6 and 129SVEV background under approved animal protocol #5358 abiding by the stan-
dards of the Canadian Council on Animal Care. Mice used were 6-month old males.

Hemocyte Isolation
30 third instar larvae of the genotypeHml > w1118,Hml > Pex5-i orHml > Pex7-i expressing cytosolic GFPwere bled into 100 mL SFX-
Insect Cell Culture Medium (GE Biosciences) containing protease inhibitors in an 8-chamber cover glass (Nunc, Thermo Fisher). He-
mocytes were treated with zymosan particles composed of heat-killed E. coli (Thermo Fisher) and were cultured at 25#C for 3 hr or
16 hr. RNA was isolated from hemocytes of adult flies of the same genotypes as described (Chakrabarti et al., 2016).

Cell Culture
Drosophila Macrophage-like Cell Lineage
Drosophila S2R+ cells were obtained from theDrosophilaGenomics Resource Center and were grown in Schneider’s Insect Medium
(Sigma-Aldrich) supplemented with 10% heat-inactivated fetal bovine serum, 50 U penicillin/mL and 50 mg streptomycin sulfate/mL.
Drosophila S2 cells expressing GFP-SKLwere a kind gift fromDr. Ronald Vale, University of California San Francisco andwere grown
in SFX-Insect Cell CultureMedium supplemented with 50 U penicillin/mL and 50 mg streptomycin sulfate/mL. The sex of animals from
which the cells were derived is indeterminate.
Murine Bone-Marrow-Derived Macrophages
Bone-marrow-derived monocytes were extracted, differentiated to macrophages and treated as previously described (Geng
et al., 2015).
Bacteria and Yeast Cells
mCherry-expressing E. coli was a kind gift from Dr. Stefan Pukatzki, University of Alberta and was cultured in LB broth at 37#C for
16 hr. GFP-expressing C. albicans was a kind gift from Dr. Alexander Johnson, University of California San Francisco and was
cultured in YPD medium at 30#C for 24 hr. S. aureus was purchased from ATCC (ATTC 25923) and was cultured in tryptic soy broth
(Sigma-Aldrich) at 37#C for 24 hr. Ecc15was a kind gift from Dr. Edan Foley, University of Alberta and was grown in LB broth at 29#C
for 24 hr.

METHOD DETAILS

Reagents
Insoluble PGN isolated from E. coli was from InvivoGen. TCT was a kind gift from Dr. William Goldman, University of North Carolina.
Rabbit antibodies to Rab5 and to Lamp1, and Alexa Fluor 488, Alexa Fluor 568 and Alexa Fluor 647 donkey anti-mouse or donkey
anti-rabbit secondary antibodies, were from Abcam. Rabbit anti-SKL antibodies and rabbit anti-rat peroxisomal thiolase antibodies
were prepared by the Rachubinski laboratory. Anti-P-p38 (9211) was from Cell Signaling. Antibodies to SCAR (P1C1-SCAR) were
developed by Dr. Susan Parkhurst, Fred Hutchison Cancer Research Center and obtained from the Developmental Studies Hybrid-
oma Bank. Antibodies to Relish (Drosophila NF-kB) (C 21F3) were developed by Dr. Svenja Stoven at Umeå University and obtained
from The Developmental Studies Hybridoma Bank. Alexa Fluor 546-conjugated phalloidin and pHrodo Red E. coli BioParticles were
from Thermo Fisher. Cy5 fluorescently labeled anti-CD11b (M1/70) or anti-F4/80 (BM8) antibodies were from BioLegend.

DHE Staining
13 106 S2 cells were treated with dsRNAs in a well of a 6-well plate for 3 days. After RNAi treatment, cells were infected for 1 hr with
E. coli. Following infection, cells were incubated with DHE and Hoechst 33342 for 5min and fixed in 4%paraformaldehyde in PBS for
4 min. Cells were then washed 3 times in PBS and either imaged immediately by confocal microscopy or analyzed by IFC.
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Measurement of NO and H2O2

For NO measurement, uninfected and infected S2 cells or flies were homogenized in 0.1 M potassium phosphate, pH 7.4, 0.015 M
potassium chloride buffer, and clarified by centrifugation. The resultant supernatants were mixed 1:1 with Griess reagent (Sigma-Al-
drich) and incubated at room temperature for 15 min. Total nitrite was estimated by spectrophotometric determination of the OD595.
Nitrite amounts were calculated against a silver-nitrite-derived standard curve. NO amounts were normalized against protein
amounts for each sample. Protein amounts were determined using a Qubit II fluorimeter (Thermo Fisher). Experiments were done
in triplicate.

For H2O2 measurement, uninfected and infected S2 cells or flies were homogenized in PBS and clarified by centrifugation. H2O2

amounts in the resultant supernatants were measured using the Amplex Red Hydrogen Peroxide/Peroxidase Assay Kit (Thermo
Fisher) and normalized to protein amounts. Experiments were done in triplicate.

PGN and TCT Treatment of S2 Cells
S2 cells were seeded into 6-well plates, grown to semi-confluency, treated with 1 mM20-hydroxyecdysone for 24 hr, and then treated
with 5 mg of PGN to induce the IMD pathway. Total RNA was extracted from cells 3 hr after addition of PGN and analyzed by
qRT-PCR.

TCT was diluted into SFX-Insect Cell Culture Medium and mixed with Cellfectin II (Thermo Fisher) by vortexing. S2 cells were
seeded into 6-well plates, incubated for 15 min at 22#C, and then treated with the suspension containing TCT at 1 mM, which was
added dropwise to cells. Total RNA was extracted from the cells 12 hr after TCT treatment and analyzed by qRT-PCR.

Drug and Lipid Treatments
To inhibit phagocytosis, S2 cells were treated before infection with 20 mM cytochalasin B (Sigma-Aldrich), or 20 mM cytochalasin
B and 10 mM latrunculin B (Cayman Chemical), for 1 hr. Murine bone-marrow-derived macrophages were treated before infection
with 20 mM cytochalasin B for 1 hr. Murine bone-marrow-derived macrophages were treated before infection with 50 mM
PtdIns(4,5)P2 (Sigma-Aldrich) or 15 mM DHA (Sigma-Aldrich) for 24 hr.

RNA Interference, Infection, and Sodium Pyruvate Treatment
dsRNAs were synthesized from a previously validated template library (Foley and O’Farrell, 2003) as described (Mast et al., 2011). S2
cells were seeded in SFX-Insect Cell Culture Medium at 90% confluency and incubated with dsRNA at 4 mg/mL for 3 days. On day 4,
bacteria or yeast cells were added to S2 cells at a ratio of 10:1. For sodium pyruvate treatment, cells on day 4 after dsRNA treatment
were treated with 10 mM sodium pyruvate for 1 h; bacteria were then added to cells at a ratio of 10:1.

CFU Counting
6 3 105 bacterial cells were added to 1.1 3 105 S2 cells in a well of a 96-well plate for 2 hr or 16 hr. Plates were subjected to centri-
fugation for 3 min at 600 3 g, and supernatants were collected. Wells were rinsed with PBS, and supernatants and washes were
pooled and subjected to centrifugation for 10 min at 3,750 3 g. The bacterial pellets were resuspended in 100 mL of LB broth
and plated at various dilutions onto LB agar. CFUs were counted after 16 hr of growth at 37#C.

To measure the bacterial or fungal burden during infection in adult flies, an individual fly from each vial infected with pathogen was
picked every 48 hr, dipped into 70% ethanol and air-dried. Individual flies were mashed in 100 mL of sterile microorganism culture
medium, and the mash was subjected to centrifugation to remove debris. The resultant supernatant was serially diluted, plated onto
solid nutrient medium, and incubated at 37#C (bacteria) or 30#C (fungi) until there were visible colonies, which were counted.

CELL MOTILITY ASSAY

S2 cells or Pex5-i cells were seeded at 90% confluence. Cells were then depleted from a defined area of the culture dish. The
depleted area was imaged (time 0); cells were then incubated for 16 hr at 25#C, and the originally depleted area was again imaged.

Cell Sorting
Fluorescently labeled S2 cells were sorted on a FACSAria III sorter using FACSDiva 6 software (BD Biosciences). GFP was excited
with a 488 nm laser, and its fluorescence was detected with 530/30 nm filters. RFP was excited with a 561 nm laser, and its fluores-
cence was detected with 610/20 nm filters. A 100 mm ceramic nozzle was used with sheath pressure of 20-25 PSI and an acquisition
rate of 3000-3500 events per second. Cells positive for both GFP and RFP were selected.

RNA Extraction and qRT-PCR
Adult flies or cells were rinsed twice with PBS, transferred to TRIzol reagent (Thermo Fisher), and snap-frozen in liquid nitrogen. Total
RNA was extracted using the RNeasy-Micro Kit (QIAGEN) following the supplied protocol. RNA was reverse transcribed using the
iScript cDNA Synthesis kit (Bio-Rad), and the synthesized cDNA was used for qPCR using the SYBR-Green PCR master mix
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(Kapa Biosystems) using a Realplex qPCR machine (Eppendorf). Samples were normalized to Rpl23 gene expression using the
2-DDCT method. Forward and reverse primer sequences used in qRT-PCR are respectively:
Rpl23, 5ʹ-GACAACACCGGAGCCAAGAACC, 5ʹ-GTTTGCGCTGCCGAATAACCAC
Att, 5ʹ-AGTCACAACTGGCGGAC, 5ʹ-TGTTGAATAAATTGGCATGG
Dpt, 5ʹ-ACCGCAGTACCCACTCAATC, 5ʹ-ACTTTCCAGCTCGGTTCTGA
Drs, 5ʹ-GACTTGTTCGCCCTCTTCG, 5ʹ-CTTGCACACAGACGACAG
Pex5, 5ʹ-AAATGCGAAGACATGGAACC, 5ʹ-TGTAACGCACACGGATGAAG
Pex7, 5ʹ-TCGAAATAGCCAGGCCATCAAG, 5ʹ-AAGGAACCGAAGACAAGGACTC
Wnt4, 5ʹ-TTTGCCATCACATTCTTCATGGG, 5ʹ-GGGTGTACTGGTAGTAGCTCA
bgm, 5ʹ-AGCACTACATGGTGAGTCAAGG, 5ʹ-GTAAGGACGCGATCGAAGC
FAR1, 5ʹ-GCGGGACGTAGTGTCTTCAT, 5ʹ-GCAGCAACTTCTCCACCAGT
ACOX1, 5ʹ-CCGTGAAGGATGTGCTCTTT, 5ʹ-GCTGTTAATCCGGCTCTGG
FarO, 5ʹ-CCAGTAATAGTGTATCGTCCTTCCA, 5ʹ-CAAGGATGGCGAGAATCC
wat, 5ʹ-AGCCACTCCAATCCAATCC, 5ʹ-TCCATCTCGGACGGATAAAT

Immunofluorescence Microscopy
Cells were fixed in 4%paraformaldehyde in PBS for 30min and then incubated for 1 hr at room temperature in 5%normal goat serum
(Sigma-Aldrich) and for 16 hr at 4#C with primary antibody at 1:100 dilution in 5% normal goat serum. Appropriate Alexa Fluor sec-
ondary antibodies were then used at 1:1000 dilution in 5% normal goat serum. After 4 washes in PBST (PBS + 0.1% (v/v) Triton
X-100), cells were mounted in DAPI Pro-Gold Antifade Reagent (Thermo Fisher) and imaged using a 100 3 oil immersion objective
(NA = 1.4)mounted on an AxioObserverM1microscope (Zeiss) coupled to anUltraview ERS spinning disk confocal imager controlled
by Volocity imaging software, v6.0 (PerkinElmer). Images were captured using a C9100 EMCCD camera (Hamamatsu) at 130 mm ver-
tical (z) spacing. Alternatively, unmounted cells were imaged while submerged in a Nunc 155411 chambered borosilicate cover glass
chamber (Thermo Fisher).

Live Cell Imaging
Bacteria or yeast cells were added to S2 cells at a ratio of 10:1. Cells were imaged while submerged in a Nunc 155411 chambered
borosilicate cover glass chamber. Images were captured every minute over 14 hr on a Zeiss AxioObserver LSM 710 confocal micro-
scope using a 40 3 1.3 oil plan-Apochromat lens. Videos were processed using Imaris 8.3.1 software (Bitplane).

Multi-Spectral Imaging Flow Cytometry (IFC)
1 3 1010 mCherry-expressing E. coli cells or 2 3 109 C. albicans cells were added to 1 3 109 S2 cells. The cells were incubated for
15 min at 4#C to allow for contact between S2 cells and bacteria or yeast contact, and then incubated for 2 hr at 25#C in SFX-Insect
Cell Culture Medium. DNA was detected by staining with Hoechst 33342. When required, S2 cells were stained with Celltracker Blue
(Thermo Fisher) for 1 hr and washed twice with PBS. Data were acquired on an ImageStream multi-spectral flow cytometer (Amnis).
Internalization Assay
IDEAS software (Millipore) was used to create a mask to identify the S2 cell membrane using bright field microscopy or by staining
with Celltracker Blue, which allowed for the differentiation between internalized and membrane-bound mCherry-E. coli particles in
3 dimensions.
Relish Nuclear Translocation
After infection with bacteria, cells were washed twice with PBS, fixed in 4% formaldehyde 20 min at 25#C, and incubated with anti-
Relish antibody (1:200 dilution) for 16 hr at 4#C. Following primary antibody incubation, cells were washed twice with PBS, 0.01%
Tween-20 and incubated with Alexa Fluor 647 donkey anti-mouse antibodies at 1:100 dilution at 4#C for 1 hr. Nuclei were stained
with Hoechst 33342 during incubation with the secondary antibody. IFC data were acquired for at least 13 105 cells. For replicates,
IFC data were analyzed independently using the algorithm ‘‘nuclear translocation’’ of the IDEAS software that created amask to iden-
tify Relish nuclear translocation in each cell.
P-p38 Quantification
Cells were washed twice with PBS, fixed in 4% formaldehyde for 20 min at 25#C, incubated with anti-P-p38 antibody (1:200 dilution)
for 16 hr at 4#C, washed twice with PBS, 0.01% Tween and then incubated with Alexa Fluor 647 donkey anti-rabbit antibodies at
1:100 dilution at 4#C for 1 hr. IFC data for 1 3 105 cells were acquired per experimental replicate. Four IFC data replicates were
analyzed independently using an algorithm of the IDEAS software that created a mask to identify the intensity of P-p38 stain in
each cell.
DHE Quantification
Cells were washed twice with PBS and stained with DHE and Hoechst 33342. Four IFC data replicates were analyzed independently
using an algorithm of the IDEAS software that created a mask to identify the intensity of DHE stain in each cell.
Macrophage Marker Detection
Murine bone-marrow-derived macrophages were fixed in 4% formaldehyde, incubated for 30 min with fluorescently labeled anti-
bodies, washed, resuspended in flow cytometry staining buffer (1% BSA in PBS), and analyzed by IFC.
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Electron Microscopy
S2 cells were grown on 13-mm poly-L-lysine-coated coverslips (Thermanox) and fixed with 4% glutaraldehyde, 2% paraformalde-
hyde, 0.2 M sucrose, 4 mM CaCl2 in 0.16 M sodium cacodylate buffer, pH 7.4, at 37#C for 60 min. Following fixation, cells were
washed with 0.05 M sodium cacodylate buffer, pH 7.4, stained with ice-cold, 1% OsO4 in 0.05 M sodium cacodylate buffer,
pH 7.4, and washed in 0.05 M sodium cacodylate buffer, pH 7.4. To increase contrast, cells were stained with 1% uranyl acetate
in 0.1 M sodium acetate buffer, pH 5.2, for 15 min and washed first in 0.1 M sodium acetate buffer, pH 5.2, and then in distilled, de-
ionized water. Cells were next dehydrated by washing in solutions of increasing ethanol concentration (30%, 50%, 70%, 80%, 90%,
95% and 100% ethanol), followed by washing in propylene oxide. Cells were infiltrated with a mixture of EMbed 812 and Araldite 502
resins and embedded in gelatin capsules. Resin polymerization was at 60#C for 48 hr. Sections (60 nm thickness) were cut on a Leica
UC7 ultramicrotome and contrasted by staining in 2% uranyl acetate and Reynold’s lead citrate. Sections were imaged using a Hi-
tachi H-7650 transmission electron microscope at 80 kV and a 16 megapixel XR111 camera (Advanced Microscopy Techniques).

Immunoelectron Microscopy
S2 cells were fixed in 0.5% glutaraldehyde/2% paraformaldehyde in 0.1M sodium cacodylate buffer, pH 7.4, for 1 hr at 4#C, rinsed in
0.075 M sodium cacodylate buffer, pH 7.4, dehydrated with a graded ethanol series (30%, 50%, 70%, and 80% ethanol), and infil-
trated with LRWhite resin (London Resin). Infiltrated samples were embedded in gelatin capsules and polymerized under UV light for
24 hr at 4#C. Following polymerization, ultrathin sections (60 nm thickness) were cut and loaded onto a 300-mesh nickel grid without
coating.

Prior to incubation with antibodies, the dried ultrathin sections were blocked overnight at 4#Cwith 8% BSA in Tris-buffered saline,
pH 7.4. Samples were incubated with the primary antibody, rabbit anti-SKL, for 90 min. Incubation with 12-nm colloidal gold-con-
jugated donkey anti-rabbit IgG (1:20 dilution) secondary antibody was performed for 40 min at room temperature. All antibodies
were diluted with Tris-buffered saline, pH 7.4, containing 1% BSA. After incubation with the primary and secondary antibodies, sec-
tions were contrasted by staining with 2% aqueous uranyl acetate for 15 min. Sections were viewed with a Philips 410 transmission
electron microscope at 80 kV equipped with a MegaView III Soft Imaging System (Olympus).

Quantification and Statistical Analysis
Statistical Analysis
All analyses were done in Prism (Graph-Pad). Statistical significance was determined using two-tailed Student’s t test, two-way
ANOVA, or the log-rank test (Mantel-Cox).

Quantification of Lamp1 Puncta
Areas of individual puncta and average number of puncta per cell were calculated using ImageJ software, applying the following
steps to each image:

1) – Open image.
File -> Open.
2 – Filter to remove noise.
Process -> Filters -> Gaussian Blur.
3 – Subtract background.
Process -> Subtract Background.
(the box marked ‘‘Light Background’’ was unticked).
4 – Set measurements to use later for filtering the puncta.
Analyze -> Set Measurements .
Tick the boxes marked ‘‘Area’’ and ‘‘Shape Descriptors.’’ Then click on the ‘‘OK’’ button
In this step, manually set in FIJI measurements to use as ‘‘filter’’ later in the workflow [which features to include or exclude in the

counting (area, shape descriptors, centroid, perimeter)].
5 – Threshold image.
Image -> Adjust -> Threshold.
Box labeled ‘‘Dark Background’’ is ticked. Adjust the sliders so that features are red colored, but the rest of the image is not. Click

‘‘Apply’’ button. This will replace grayscale image with an ‘‘8-bit binary image.’’ All ‘‘red’’ pixels are converted to a value of ‘‘255,’’
while all non-red pixels will be given a value of ‘‘0.’’

6 – Fill in any holes in the nuclei.
Process -> Binary -> Fill Holes
7 – Separate ‘‘Touching’’ puncta.
Process -> Binary -> Watershed
8 – Perform the analysis.
Analyze -> Analyze Particles.
In this dialog box the algorithm starts to include or exclude puncta based on their attributes. ‘‘Size’’ smaller than 1 square pixel.

‘‘Circularity’’ set range: 200-1.
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Measurement of Peroxisome Displacement
S2 cells expressing GFP-PTS1 and infected with E. coli were recorded by live cell imaging for 13 hr, and peroxisome displacement
was analyzed using Imaris 8.3.1 software, applying the following steps:
Red Channel (bacteria) was turned off.
Green Channel (peroxisomes): min = 0.0, max = 1981.78, gamma = 1
Segment cell individually using Spots function (ROI) = cube
Spots:
1) Select segment only a ROI. Select: track spots over time
2) Define ROI (use ESC to switch modes - 131 3 131 3 13z) all timepoints
3) Channel 1 estimate XY diameter = 0.2 mm
Select: background subtraction.
4) Spots Filter-Quality 180-256. 800-1600 spots over all timepoints
5) Edit (do not remove any spot unless clearly outside known cell volume)
6) Tracking: Max distance = 1.37 mm; Max gap size = 3. Select: fill the gaps
7) Classify tracks:
Setting: Tracks path- Select: displacement
Radius scale = 0.1
Points style = sphere radius scale = 1.0
Create Filter
Duration > 450 s
Selects for tracks = 50% of total
Experimental (t) = movement
Select Finish
Repeat for 15-20 cells with clear peroxisome signal avoiding cells at the edge.
At the end of the analysis:
Surface: Mark bacteria (red)
1) Track surface overtime
2) Channel2-Ch2: Select: absolute intensity
3) Min = 441 at t 380
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Figure S1, related to Figure 1. Pex5 and Pex7 Are Required for Phagocytosis in Primary 
Larval Hemocytes 
(A) Pex5 and Pex7 transcript levels were reduced in Pex5-i and Pex7-i cells, respectively, relative 
to their levels in control S2 cells. The values reported represent the averages of 5 independent 
experiments ± SD. Statistical significance was determined using Student’s t-test; *** p < 0.001; 
** p < 0.01. (B) Primary larval hemocytes isolated from control Hml>GFP larvae showed greater 
numbers of internalized E. coli (red) 3 h post-infection than do primary hemocytes isolated from 
Hml>GFP:Pex5-i and Hml>GFP:Pex7-i larvae. Scale bar, 10 μm. (C) Quantification of the 
internalization of E. coli by primary larval hemocytes isolated from control Hml>GFP, 
Hml>GFP:Pex5-i and Hml>GFP:Pex7-i larvae. The values reported represent the averages of 25 
individual cells per genotype ± SD. Statistical significance was determined using Student’s t-test; 
*** p < 0.001; ** p < 0.01. 
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Figure S2, related to Figures 1, 2 and 3. Pex5-i and Pex7-i Cells Exhibit Defects in Their 
Cytoskeleton and a Reduced Ability to Migrate 
(A) Actin (blue) in Pex5-i and Pex7-i cells was more disorganized than in control S2 cells. 
Peroxisomes were marked by GFP-SKL (green). Actin was detected by staining with phalloidin. 
(B) Pex5-i cells migrated more slowly than control cells. Peroxisomes were marked by GFP-PTS1 
(green). The dashed orange lines indicate the area that was cleared of cells at time 0. (C) Indirect 
immunofluorescence microscopy showing that the distribution of SCAR, an actin-nucleating 
protein required for phagocytosis, was altered in Pex5-i and Pex7-i cells. Arrows point to localized 
concentrations of SCAR protein seen in control S2 cells but rarely observed in Pex5-i or Pex7-i 
cells. Scale bars, 10 μm. (D) IFC measurement of the percentage of E. coli cells attached to the 
plasma membrane (membrane-bound) or internalized by cells of the designated genotypes. The 
values reported represent the averages of 4 independent experiments ± SD. Statistical significance 
was determined using two-way ANOVA. *** p < 0.001; ns = not significant. (E) Vector analysis 
of the movement of peroxisomes labeled with -SKL in S2 cells. Arrows indicate the start 
(tail) and end (head) points of individual peroxisomes that showed significant movement over 
7.5 min. Panel a, in a cell not in contact with E. coli, peroxisomes (green) moved randomly 
within the cytoplasm; panel b, in a cell in close contact with a single mCherry-labeled E. coli 
(red), peroxisome movement was concentrated in the cytoplasm adjacent to the bacterium; panel 
c, in a cell in contact with multiple E. coli cells, there were corresponding regions of restricted 
peroxisome movement adjacent to each bacterial cell. Scale bars, panels a and c, 2 μm; panel b, 1 
μm. (F) qRT-PCR confirmation of the reduction in Pex5 and Pex7 transcript levels in Act>Pex5-i 
and Act>Pex7-i flies, respectively, relative to control flies. Values reported represent the averages 
of 5 independent experiments ± SD. Statistical significance was determined using Student’s t-test; 
*** p < 0.001. 
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Figure S3, related to Figures 3, 4, 5 and 6. Peroxisomes Are Required for Activation of the 
Immune Response and Organism Survival 
(A) Survival curve for control adult flies after injection with either vehicle (PBS) alone or vehicle 
+ Ecc15. (B) Survival curve for Act>Pex5-i adult flies systemically expressing a dsRNA targeting 
Pex5 after injection with either vehicle (PBS) or vehicle + Ecc15. Act>Pex5-i flies were equally 
sensitive to injection with vehicle or vehicle + Ecc15. (C) Survival curve for Act>Pex7-i adult flies 
systemically expressing a dsRNA targeting Pex7 after injection with either vehicle (PBS) or 
vehicle + Ecc15. Values reported in panels A-C represent the averages of 4 independent 
experiments ± SD. (C-G) Adult flies of the designated genotypes were orally infected with Ecc15 
(D), S. aureus (E) or C. albicans (F), or were infected by injection of Ecc15 (G). Pathogens were 
isolated from flies and plated onto solid nutrient medium, and the numbers of CFUs were counted 
2 days and 4 days after infection of flies for panels D-F or 24 h after infection of flies for panel G. 
Note the significant increases in pathogen load in Act>Pex5-i and Act>Pex7-i flies with all 
pathogens. (H) NO amounts (nmol/fly) in clarified lysates of control, Act>Pex5-i and Act>Pex7-i 
flies. Lysates were prepared from uninfected flies (-) or flies infected with Ecc15 (+) for 4 h. The 
values reported in panels C-H represent the averages of 3 independent experiments ± SD. 
Statistical significance was determined using two-way ANOVA; **** p < 0.0001; *** p < 0.001; 
** p < 0.01. 
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Figure S4, related to Figures 5, 6 and 7. Quantification of the Activation of the Immune 
Response 
(A) The induction of AMP gene expression in response to Ecc15 infection was reduced in cells 
depleted for Rel transcript. Quantification of Drs, Dpt and Att expression in Ecc15-infected S2 
cells (control) and infected Rel-i cells. The ratio of the expression of a particular transcript in 
control infected cells to its expression in control uninfected cells was determined, and set to 1. The 
ratio of the expression of a particular transcript in infected Rel-i cells to its expression in uninfected 
Rel-i cells was determined, and that ratio was divided by the corresponding ratio for control cells 
to achieve a relative expression induction in Rel-i cells. (B) Quantification of Dpt expression in 
Ecc15-infected Cat-i cells and infected control cells. Values reported are relative to expression of 
Dpt transcript in uninfected cells of the same genotype. (C) Quantification of Dpt expression in 
Ecc15-infected S2 cells either untreated (control) or treated with 10 mM H2O2 for 1 h or 16 h. 
Values reported are relative to the expression of Dpt transcript in uninfected and untreated S2 cells. 
(D) Quantification of Dpt expression in S2 cells uninfected (-) or infected with Ecc15 (+) and 
either untreated (-) or pretreated (+) with sodium pyruvate. Values reported are relative to the 
expression of Dpt transcript in uninfected and untreated S2 cells. (E) Quantification of Dpt 
expression in Pex5-i cells uninfected (-) or infected (+) with Ecc15 and either untreated (-) or 
pretreated (+) with sodium pyruvate. Values reported are relative to the expression of Dpt 
transcript in uninfected and untreated Pex5-i cells. Values reported in panels A-E represent the 
averages of 4 independent experiments ± SD. Statistical significance was determined using 
Student’s t-test; *** p < 0.001; ** p < 0.01; ns = not significant. 
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Figure S5, related to Figure 7. IFC and Immunofluorescence Microscopy of Murine 
Macrophages, and Reduction in Expression of Transcripts Encoding Enzymes of Lipid 
Metabolism in S2 Cells Depleted for Pex5 or Pex7 Transcript 
(A and B) Representative IFC outputs of the population of murine bone-marrow-derived 
macrophages positive for antibody recognition of the macrophage marker CD11b (A) or F4/80 
(B). (C and D) Representative immunofluorescence microscopy staining of macrophages from 
Pex7+/- mice or Pex7-/- mice using antibodies to CD11b (C) and F4/80 (D). Scale bars, 10 μm. (E) 
Immunofluorescence microscopy detection of peroxisomal thiolase localization in macrophages 
from Pex7+/- mice or Pex7-/- mice. Scale bars, 10 μm. (F) Induction of expression of transcripts for 
enzymes involved in lipid metabolism is reduced in Ecc15-infected S2 cells depleted for Pex5 or 
Pex7 transcripts. Quantification of expression was done by qRT-PCR. wat (waterproof, CG1443), 
a fatty acyl-CoA reductase; FAR1 (CG5065), a fatty acyl-CoA reductase similar to human FAR1; 
bgm (bubblegum, CG4501), a fatty acyl-CoA ligase; FarO (CG18031), a fatty acyl-CoA reductase; 
ACOX1 (CG4586), a fatty acyl-CoA oxidase similar to human ACOX1. Values reported are 
relative to the expression of a particular transcript in uninfected cells of the same genotype and 
represent the averages of 3 independent experiments ± SD. Statistical significance was determined 
using Student’s t-test; *** p < 0.001; ** p < 0.01. 
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